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General Information 
 

Welcome 
Welcome to the SCIA Engineer Tutorial Frame Concrete. SCIA Engineer is an integrated, multi-material 
structural analysis and design software for all kinds of structures. Its wide range of functionality makes it 
deployable for any construction type: design office buildings, industrial plants, bridges or any other 
project, all within the same easy-to-use environment.  
  
The program treats the calculation of 2D/3D frameworks, design and check of reinforcement included. 
Besides frames, it is also possible to dimension plate structures, inclusive of advanced concrete 
calculations. 
 
The complete process of calculation and design has been integrated in one program: input of the 
geometry, input of the calculation model (loads, supports ...), linear and non-linear calculation, output of 
results, reinforcement design and checks according to various codes, generating the calculation report, 
etc. 
 
SCIA Engineer is available in three different editions: 
 
License version  
The license version of SCIA Engineer is secured with a ‘dongle’, a hardlock, which you apply to the USB 
gate of your computer or a softwarematic license in your network. 
SCIA Engineer is modular and consists of various modules. The user chooses from the available 
modules and composes a custom design program, perfectly tuned to his needs. 
In the general product overview of SCIA Engineer you will find an overview of the different modules or 
module editions that are available. 

 
Viewer mode  
If the program doesn’t find a licence it can be used as a viewer only. That means that any project can be 
opened, properties of entities can be checked, if the calculation has been done also results can be seen 
and report can be printed. 
However, no change of the model is possible, no calculation can be run, no new output can be created. 
 
Student version  
The student version has the same possibilities as the license version for all of modules. This version is 
also secured by a softwarematic protection. 
The output contains a watermark “Student version”. Projects that are stored in the student version cannot 
be opened in the license version. 
 

SCIA Engineer Support 
You can contact the SCIA Engineer support service 
 
By e-mail 

Send an e-mail to support@scia.net with a description of the problem and the concerning *.esa file, 
and mention the number of the version you are currently working with. 

By telephone 
 For various phone numbers to different offices visit our page https://www.scia.net/en/contact/offices 
Via the SCIA Customer Portal website 

http://www.scia.net/en/portal 

Websites 
Link to Manuals and Tutorials  

https://www.scia.net/en/support/downloads/scia-engineer-manuals-tutorials 
Link to eLearning 
 http://elearning.scia.net/ 
Link to Web help 

http://help.scia.net/ 
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Introduction 
 
This Tutorial describes the basic functions of SCIA Engineer, the input, analysis and design of a 3D 
steel frame.  
Before you start, you must be familiar with your operating system: for instance working with dialogues, 
menu bars, toolbars, status bars, handling the mouse, etc. 
First, we will explain how to create a new project and how to setup your structure.  After the geometry 
and load input, the structure will be calculated and the results can be viewed.   
Next, we will discuss the input of the buckling parameters and we will perform the steel check, the 
profile optimization and calculate steel connection. 
The Tutorial ends with a brief introduction to the calculation report. 
 
The figure below shows the calculation model of the structure to be designed: 
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Getting started 

 

Starting a project 
Before you can start a project, you need to start the program first. 
 

1. Double-click on the SCIA Engineer shortcut in the Windows Desktop, or 

2. If the shortcut is not installed, click [Start] and choose All apps > SCIA Engineer 18.0 > SCIA 
Engineer 18.0. 

 
If the program does not find any protection, you will see a dialogue indicating that no protection was 
found.  You are offered to run Protection setup and select appropriate protection type (e.g. try-out), or 
run the program in Viewer mode.  
 
For this Tutorial, you must start a new project with standard licence. 
 

Starting a new project 

 

1. When the Project manager dialogue appears, click Blank project. 

 

2. You can also start new project with an icon  in the toolbar or with a key combination Ctrl+N.  
 

Now, the Project data dialogue is opened.  Here, you can enter general data about the 
project. 
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3. In the Basic data group, enter your preferred data. These data can be mentioned on the 
output, e.g.  in the report and on the drawings. 

4. Choose the Structure: Frame XYZ (to limit input possibilities to 1D members in 2D plane only) 
and Model: One. 

5. In the Material group, tick Steel checkbox. 

Material is the only required setting to proceed 

Choose S235 from the combo-box. 

6. In the Code frame select National Code EC-EN and National annex: Standard EN 

7. Confirm your input with [OK] button. 
 
 
Note: 
On the Functionality tab, you choose the options you need.  The non-selected functionalities will be 
filtered from the menus, thus simplifying the program. We don’t need any additional functionality for this 
tutorial example. 
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Project management 
 

Save, Save as, Close and Open 
 
Before entering the construction, we first discuss how to save a project, how to open an existing project 
and how to close a project. When running a project of this Tutorial, the project can be saved at any 
time. That way you can leave the program at any time and resume the project from there afterwards. 
 

Saving a project 

Click on   in the toolbar or press Ctrl+S. 
 
If a project has not yet been saved, the dialog box Save as appears. Click on the arrow in the list Save 
to choose the drive you want to save your project in. Select the file in which you want to put the project 
and click on [Open]. Select the subfolders. Enter the file name in File name and click on [Save] to 
save the project. 
 
If you choose File > Save as in the main menu, you can enter a new/other drive, folder and name for 
the project file.  
 
Note: Autosave function creates a backup file every 15 minutes by default. These backup projects can 
be found in folder c:\Users\*username*\Documents\ESA16.0\Autosave\ 
 

Closing a project 

 
To close a project, choose File > Close in the main menu  
or click the smaller X button on top right corner of the 
application. 
 
A dialog box appears asking if you really want to save the 
project. Depending on your choice, the project is saved and the active dialog is closed. 
 

Opening a project 

Click on   to open an existing project. 
 
A list with projects appears. Select the desired project and click [OK] (or double-click on the project to 
open it). 

Start project manger 

Click on   to open project manager. Here the recently closed project can be found, as well as 
sample projects. 
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Geometry input 

Input of the geometry 
If you start a new project, the geometry of the structure must be entered. The structure can be entered 
directly, but you can also use for instance templates with parametric blocks, DXF files, DWG files and 
other formats. 

Profiles 

When entering one or more 1D structure elements, a profile type is immediately assigned to each 
member. By default, the active profile type is represented. You can open the profile library to activate 
another profile type. If you want to add a structure part before a profile type has been defined, the 
profile library will automatically be opened. 
 

Adding a profile 

1. Click on the Cross-Sections  icon in the toolbar. 

The cross-sections manager is opened. If no profiles have been entered in the project, the 
New cross-section window will be automatically opened. 

 

            
 

2. Click Profile library in the group Available groups. 

3. In the Available items of this group, you can choose I profile  . Choose HEA 200 
from the list. 

4. Click [Add] or  to add the profile to the project. 
 

5. The Cross-section window appears.  
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6. Click [OK] to confirm, the profile is added to the Items in project frame. Add IPE 180 and IPE 
160 in a similar way. 

7. In the Available items for this group, you can choose an angle section  . Choose 
HFLeq 70x70x7 from the list. 

8. Click [Add] or  to add the profile to the project. Click [OK] to confirm, the profile is added to 
the Items in project frame. 

9. Click [Close] in the New cross-section window, the Cross-Sections manager appears. 
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10. Click [Close] to close the Cross-Sections manager and to return to the basic modelling view. 

 

Geometry 

Structure menu 

1. When a new project is started, the Main tree is automatically opened on left hand side. If you 
want to input/modify the structure you must double-click on Structure in the Main window. 

                               
 

2. In the Structure menu, you can choose different structural elements to enter the structure. 
 

To model the structure you must enter the first frame. Then, this frame will be copied and the wind 
bracings and the horizontal beams will be added. 
You can use columns and bars to enter the frame. SCIA Engineer however offers multiple Catalogue 
blocks, allowing for a smooth and simple input of the structure. 
 

Entering a frame using a Catalogue Block 

1. To enter a new frame, use the option Advanced input > Catalogue Blocks in the Structure 
service. Block selection manager is opened. 

               
 

2. In the Available Groups group choose the first option Frame 2D 

3. In the Available items of this group you can choose the first shape  .  
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4. Confirm your choice with [OK]. The Geometry block window appears. 

 
 

5. Now, enter the frame dimensions: L = 12 m, H1 = 5 m and H2 = 1 m 
 

6. In the combo-box with cross-section selector choose HEA 200 for the Column and IPE 180 for 
the Beam. 

 

7. Confirm your input with [OK]. The Catalogue block manager appears. 
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8. Click [OK] to return to the modelling view. The frame is now graphically represented by thin 
blue lines attached to mouse cursor. You are now asked to select insert point. 

 

9. The frame is positioned with the left column in the origin of 
the coordinate system. Type the coordinates 0;0 in the 
Command line and press <Enter> to confirm your input. 

              

10. Finish the input with the <ESC> key. 
 
 
Notes: 
The properties of selected elements are shown and can be modified in the Properties window on the 
right hand side of the user interface. 
If no cross-section has been defined in the project, the New cross-section window will automatically 
appear as soon as you try to enter a structural element (column, beam…). 
With Zoom All button in the toolbar, or double-click with the mouse wheel, you can visualize the entire 
structure. 
The use of , or ; to separate coordinates depends on the regional settings of Windows. You can also 
use spacebar to define coordinates instead of the two. 
 
 
After input of the first frame, it can be copied to obtain the hall frames easily.  As you need two copies, 

you can use the Multiple copy function . 
 
 

Create multiple copies 

1. First select all (already modelled) entities to be copied.  As you must copy all members, you 

can use the Select All icon  
 
This way all bars and nodes are selected; this is represented by dashed violet line: 
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2. Now, you can use the Multiple copy option  (Modify > Multiple copy). 
 

     
 

3. In the Number of copies field enter 2. 
 

4. To manually set the distance between the frames, deactivate the Define distance by cursor 
option.  Now, you can enter the distance 6 m in direction Y. 

 

5. Click [OK] to confirm your input. New frames are modelled. 
 

6. Press <ESC> to cancel the selection. 
 

                        
Connecting beams of the frames can be entered when the frames are entered. The start and end 
nodes of the beams are already known, i.e. begin and end nodes of the entered members.  Therefore 
you do not have to enter the beams by means of coordinates; instead of that you can use the Cursor 
snap settings. 
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Cursor snap settings 

1. Double-click on the Cursor snap settings icon  in the Command line or click on the 

button  at the lower right corner of the application frame. The Cursor snap 
settings window is opened. 
 

2. Activate the options a) and b) to highlight midpoints and end points of bars in this project. 

 
3. Click [OK] to confirm your setup. Now, you can input the beams. 

 

Entering a beam 

1. To enter a new beam, use the Beam command in the Structure service. 
2. In the CrossSection field, choose the third section, CS3 - IPE160.  

 
3. As the structure type Frame XYZ has got two horizontal axes (i.e. X and Y), you must indicate 

the right direction for the horizontal beam in the Direct field. Choose axis Y possibility. 
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4. The beam length is 6 m. 
 

5. The insertion point is (as default) set to begin so that the left point determines the position of 
the beam. 

 

6. Confirm your input with [OK]. 
 

7. Now, you can enter the beam by clicking with your mouse on the top node of the left-hand side 
column of the first frame and similar node on the middle frame: 
 

      
8. Enter the other beams of the roof in a similar way, always by clicking the top nodes of columns 

or inclined beams. 
 

 
9. Press <ESC> to finish the input. 
 

10. Press <ESC> once more to cancel the selection. 
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Note: 
The Multiple copy option also allows for the automatic input of the beams connecting the frames. 
 
 
In the first span (between the first and second frame) two more horizontal beams are located. To enter 
these beams you could use the Beam command.  SCIA Engineer however enables copying these 
entities manually. 
 

Copying entities 

1. First select the entity to be copied. As this is a horizontal beam, you can select one of the 
entered beams with the left mouse button. Violet colour indicates that the bar has been 
selected. Properties of the bar are shown in the Properties window. 

 

2. Click with the right mouse button anywhere in the user environment. Context menu lists the 
available possibilities for the selected entity: 

  
3. In this menu, choose the option Copy. 

Note: Instead of points 2 and 3 you can also use CTRL+C key shortcut. 

4. The program asks the Start point of the copy.  Click with the left mouse button on the start 
node of the selected bar 
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5. Now you must enter the End point, i.e. the position where the starting point should be copied.  
As the new beams start in the middle of the columns, the midpoint of one of the columns in the 
first frame is selected. 

 
As Midpoints option was already activated for the Snap settings, you can simply pick the 
centre point of the column. 
 

6. When the first beam is copied, the command remains active until you press <ESC>, so that 
you can also pick the midpoint of the second column of the first frame to enter a horizontal 
beam at that position. 

 

7. Press <ESC> to finish the input. 
 

8. Press <ESC> once more to cancel the selection. 
 
After input of the horizontal beams, you can enter the bracings.  
The bracings are not vertical columns or horizontal beams but rather arbitrary 1D members. Therefore 
you must use the Member command in the Structure service. 
 

Entering bracings 

1. To enter a new bracing, use the Member command in the Structure service. 
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2. In the Type field, choose Wall Bracing (0). This specification is considered for the 
STRUCTURAL model only and does not influence the calculation model or the results. 

 

3. In the CrossSection field, choose the fourth section, CS4 - HFLeq 70x70x7. Note that no 
length or direction is requested this time, as you will define the geometry afterwards. 

 

4. Confirm your input with [OK]. 
 

5. Now, the bracings can be entered between the second and third frame. Click on the start and 
end nodes of the columns to draw diagonal: 
 

 
6. Repeat selecting start nodes and end nodes until all bracings are modelled. 

 
7. Press <ESC> to finish the input. 

 

8. Press <ESC> once more to finish the selection 
 
The structure is completely set up. Now, you can finish the geometry input by adding end conditions, 
i.e. enter haunches, hinges and supports. 

 
 



 

17 

Haunches 

In SCIA Engineer every member is regarded as prismatic, with constant cross-section, until a haunch is 
entered. Haunches are entered on the roof beams in this project, at column sides. Haunch is defined 
by the following parameters: 
 

 A section with variable height 
 A length, over which the variable height must vary up to 0 

 

Entering Haunches 

1. To enter a new haunch, use the 1D member > 1D member components > Haunch 
command in the Structure menu. 

 
2. As indicated, a haunch requires a cross-section with a possibility to create variable 

dimension(s). Since this project does not contain any variable profiles yet, the New cross-
section window automatically appears. 
 

3. Select in the Available groups the Haunch group. 

4. In Available items of this group, choose a I + I var profile  

 

5. Click [Add] or   to add the profile to the project. The Cross-Section window appears. 
Here, the properties of the variable section can be changed. 
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6. In the I sections field, change the section in an IPE 180 by clicking the  button behind the 
section type. 

 

7. When the correct I-section is set, the variable height va (mm) is set to 150mm 
 

8. Confirm your input with [OK] and use button [Close] to close the New cross-section 
dialogue. 

 

9. The Cross-Section manager appears; click [OK] to close this window as well. 
 

10. Now, the Haunch on beam window is opened. 
 

 
11. In the Position field, choose Begin to position the haunch at the start node of the member. 
 

12. In the Coord. definition field, choose the option Abso to indicate that the length, over which 
the variable height must vary, can be entered in absolute units, i.e. in meter. 
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13. When the Coordinate Definition is adapted, the length of the haunch can be entered in the 
Length x [m] field.  For this project, enter length 1 m. 

 

14. Confirm your input with [OK] 
 

15. Now, the program asks to indicate the members on which a haunch must be entered.  Select 
the 6 roof beams with the left mouse button: 
 

      
16. Press <ESC> to finish the input. 
 

17. Press <ESC> once more to cancel the selection. 
 
 To visualize this model, you need to click the following buttons in the command line: 

 
 Show/hide surfaces to show the surfaces of the sections. 
 Render geometry to obtain a rendered view of the members. 
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In the command line, click Show/hide surfaces  and Render geometry  to deactivate both 
options and visualise the system lines of the members again. 
 
Note: 
A haunch overwrites specification of the original cross-section. For this project, this specifically means 
that the profile of the roof beam is replaced by the I + I var profile. If the haunch is removed, the I + I 
var profile will be maintained instead of the I-section of the roof profile. 
 

Hinges 

In SCIA Engineer, every node where two or more members connect is regarded as fixed, until a hinge 
is entered and some rotations are released. 
In this project, the diagonals should be connected with the other members in a hinged way. Therefore, 
you must enter hinges manually. 
 

Entering hinges 

1. To enter hinges, use the Model data > Hinge on beam command in the Structure menu. 
 

                
2. The hinges are put to both ends of the diagonals; therefore choose Both for the Position 

when dialogue Hinge on beam pops-up. 

 
3. To obtain a hinge, the rotation fiy is set to Free, the translations and the other rotations remain 

Rigid. In this way, the diagonals will be exclusively hinged in the planes of the sidewalls. 
 

4. Confirm your input with [OK]. 
 

5. The hinges are added when you click the diagonals with the left mouse button. 
 

6. Press <ESC> to finish the input. 
 

7. Press <ESC> once more to finish the selection. 
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Note: 
Hinges are always defined with regard to the local coordinate system of a member. 

Increase the scale for input data in toolbars  if you feel that the circle 
sign of hinge is too small. 
 
 

Supports 

The geometry input can be completed with supports. The column bases are modelled with hinges. 
 
Before adding the supports, you first can select the nodes to position the supports (for this Tutorial).  
You can select these nodes manually, one by one, but SCIA Engineer offers a simple method to select 
multiple entities based on common property. 
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Selecting elements by property 

1. To select all column bases, select one of the bottom nodes, by drawing a frame from the left to 
the right with the mouse cursor. 

 
2. The Properties window shows the properties of this node: 

 

 
3. Now, choose the property to be used for the selection of the entities.  For this project, you want 

to select all bottom nodes. The common property of these nodes is their coordinate in global Z 
direction. 
Click with the left mouse button on the Coord Z (m) property to select appropriate row. The 
table cell is highlighted by blue colour. 
 

4. Choose the Select elements by property button . The program will search all entities with 
the same property.  In this example, the program will select all nodes, for which the Coord Z 
(m) property corresponds to 0 m. 
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The column bases are selected; now, supports can be added to these nodes. 
 

Entering supports 

1. To enter supports, use the Model data > Support > in node option in the Structure menu. 

 
2. You can easily define all 6 end conditions by choosing Constraint Hinged, so that all 

translations Rigid and all rotations Free. 

 
3. Confirm your input with [OK]. The supports are automatically attributed to the selected nodes. 
 

4. Press <ESC> to finish the selection. 
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Notes: 
If you draw the box from the left-hand side to the right-hand side with the mouse cursor, only entities 
which are completely inside will be selected.  If you draw the rectangle from the right-hand side to the 
left-hand side, the entities which are completely in the rectangle as well as the entities that intersect 
with the rectangle will be selected. 
 
The Command line includes a number of predefined supports.  For this project, you could have used 

the Hinged support  icon. 

Similar to the selection of supports, you could have used the Select elements by property  option 
to select all diagonals, where hinges had to be entered.  The determinant property here would have 
been the CrossSection. 
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Check Structure data 
After input of the geometry, the input can be checked for errors by means of the option Check 
Structure data. With this tool, the geometry is checked for duplicate nodes, zero beams, duplicate 
members, wrong references of hinges or supports etc. However, this tool does not check if the 
structure is correctly supported or if it is a mechanism. 

Checking the structure 

1. Double-click on the Check structure data option in the Structure service 

 or click on the  icon in the 
toolbar. 
 

2. The Structure data check window appears, listing the different available checks. 

                
 

3. Click [Check] to perform the checks. 
 

4. The Data Check Report window appears, indicating that no problems were found. 
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5. Close the check by clicking [OK]. 
 

6. In case of any problem SCIA Engineer can automatically correct the structure data (delete 
duplicated entities, correct wrong reference, etc.) 

Connecting entities 

A column and a roof girder have one common node. The end node of the column (for instance) is the 
begin node of the roof girder. This girder is connected to the column automatically. 
The two girders modelled in the middle of columns are not touching the column in nodes. The end 
nodes of the beams are located in-between the column nodes and therefore are not yet connected to 
the columns. In this paragraph, we will explain how to connect the bars to each other. It might be 
especially important for future editing and smooth calculation. 
  
To display the names of the bars and nodes, you can activate the labels by means of the buttons in the 
Command line. 

Activating node labels 

Node labels are activated by means of the  icon at 
bottom of the modelling window. 

Activating member labels 

 Member labels are activated by means of the  icon 
at bottom of the modelling window. 
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When you select column B1 with the left mouse button, the properties are displayed in the Properties 
window: 

 
This window indicates that the start node is N1 and the end node N2. Node N18 is not part of the 
column. To connect beam B21 to the columns, use the Connect members/nodes option. 
 

Connecting entities 

1. Press <ESC> or click the Cancel selection  icon to deactivate any selection of entities. 
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2. Double-click on the Model data > Connect members/nodes option in the Structure service 

 or click the  icon in the toolbar. 

 
3. A dialogue asks if all nodes must be connected 

to bars: 
              
 

4. Click <Yes>. 
 

5. The Setup for connection of structural 
entities dialogue box now appears. 

              
 

6. Confirm the settings by clicking <OK>. 
 

7. A window appears to indicate the number of connected nodes: 

              
 

8. Connected nodes are represented in the graphical screen by means of double red lines: 

 
When you select for instance girder B21, the Properties window will show that node N18 connects 
the girder with column B1 and that node N19 connects the girder with column B5. 
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Note: 
If a possible active selection is not deactivated when the Connect members/nodes command is used, 
program will only search the nodes to be connected in this selection only and not in the entire structure.  
It is also possible to run the two previous operations at once. Therefore you have to check the option 
Check (merge duplicate nodes, erase invalid entities) in the Setup for connection of structural 
entities dialogue box. 
 

9. Click [Close] below the Structure menu to return to Main tree.  
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Graphic representation of the structure 
 

Edit view 

Within SCIA Engineer there are several possibilities to edit the graphic representation of the 
construction. Below you will find the most important options: 
 

 Edit the view point on the model 
 Set a view direction 
 Use the magnifier 
 Edit view parameters through the menu View parameters 

 

Editing the view point on the model 
 
Set view point through the wheels. Bottom right of the graphic window there are three wheels; two are 
horizontal and one is vertical. With these wheels you can zoom in on the construction or turn it.  
 

1. To be able to zoom in on the construction or to turn the model, click on the wheel (the cursor 
will change into a hand), keep the left mouse button pressed and move the wheel 

      OR 
Set the view point by combining the buttons and mouse: 

 
2. Press CTRL + right mouse button at the same time and move the mouse to turn the 

construction. 
3. Press SHIFT + right mouse button at the same time and move the mouse move the 

construction. 
4. Press CTRL + SHIFT + right mouse button at the same time and move the mouse to zoom in 

or out on the construction. 
 
Remark: 
 
If the structure is being turned while a node is selected, the structure will turn around the selected 
node. 
You can also easily zoom in and zoom out with the mouse wheel. The same mouse wheel can be 
used to move the model in case you press it and hold. Double-click of the wheel zooms the structure 
so that it can be seen completely (the whole modelling windows is filled by the structure). 
 

Setting a view direction with regard to the global coordinate system 

1. Click on the button View in direction X for a view in the X-direction. 

2. Click on the button View in direction Y for a view in the Y-direction. 

3. Click on the button View in direction Z for a view in the Z-direction. 
 
Remark: 
 
You can also type the letter X, Y, or Z into command line and click <Enter> to activate the view in 
desired direction. 

The magnifier 
 

 Use  to enlarge. 

 Use  to decrease. 

 Use  to zoom in on a window. 
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 Use  to view the whole structure. 

 Use  to zoom in on the selection of modeling entities. 
 

Editing view parameters through the menu View parameters 
 

Click in the graphic window on the right mouse button. The following shortcut menu appears: 
 

                             
 
Remark: 
 
If an entity was selected previously, you can define a setting that only applies to the selected elements. 
(An adapted shortcut menu appears). 

 
Choose the option Set view parameters for all. The window View parameter setting appears. 
The menu consists of various tabs for various data. You can set the view parameters for all entities 
or just for the selected entities. 
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View parameters – Structure 
 
 Through the tab Structure the representation of the 
different entities can be adapted. In the group 
Structure the following items are important for this 
project: 
 

 Style and colour: You can display the colour 
per layer, material, cross-section, structural 
type or design group. 

 Draw cross-section: With this option 
checked the symbol of the cross-section is 
displayed on every 1D member. 

 Local axes: With this option the local axes of 
the elements are activated. 

 
                  
 
 
 
 
 
 

View parameters – Labels 
 
Through the tab Labels, the labels of different entities 
can be displayed. In the group Beam labels the 
following items can be displayed in the label: 
 

 Name: Show the name of the cross-sections in 
the label (e.g. CS.) 

 Cross-section type: Show the cross-section 
type in the label (e.g. Rectangle (500; 500)). 

 Length: show the length of the member in the 
label (e.g. 6,000 m). 

 
                     
 
 
 
 
 
 

View parameters – shortcuts 
 
In the tool bar above the Command line, several frequently used options are grouped among which: 
 

 Show/hide surfaces  to show the surfaces of the cross-sections. 

 Render geometry  to view the rendered members. 

 Show/hide supports  to show supports and hinges. 

 Show/hide load  to show the load case. 

 Show/hide other model data    to show other model data (like hinges, internal nodes, …). 

 Show/hide node labels   to view the label of the nodes. 

 Show/hide member labels   to view the label of members. 

 Set load case for view  to edit the active load case. 



 

33 

 Fast adjustment of view parameters on the whole construction   to quickly access to 
the options from the menu View parameters. 

 
After rendering, the following picture of the structure is obtained (Axonometric view): 
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Loads and combinations 

Load Cases and Load Groups 
 
Each load is attributed to a load case. One load case can contain different load types. To each load 
case, properties are attributed which are determinant for the generation of combinations. The action type 
of a load case can be permanent or variable. 
Each variable load case is associated with a load group. The group contains information about the 
category of the load (service load, wind, snow…) and its appearance (default, together, exclusive).  In 
an exclusive group, the different loads attributed to the group cannot act together in a single combination. 
For default combinations, on the other hand, the combination generator allows the simultaneous action 
of the loads of a same group. 
The way in which load cases are defined is decisive for the load combinations created by the generator. 
We recommend that you thoroughly read the chapter about loads and combinations in the reference 
manual.  
 
Two load cases are entered in this project: 
 
LC1: Permanent Load Case: Self weight of the bars + Roof weight 
LC2: Variable Load Case: Side wind on the frames 
 

Defining a Permanent Load Case 

1. Double-click on in the Main tree. 
 

2. Before you can define loads, you must enter load cases first. Since this project does not 
contain any load cases yet, the Load Cases manager will automatically appear. 

 

3. By default, the load case named LC1 is created. This load is a permanent load of the Self 
Weight load type. The self weight of the structure is automatically calculated, although not 
graphically displayed. 

 
4. Since you will also manually enter loads in the first load case of this project (Roof Weight), you 

must change the Load Type to Standard. 
 

5. In the Description field, you can describe the content of this load case.  For this project, enter 
the description “Self Weight Structure”. 
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Defining a Variable Load Case 

1. Click  or  to create a second load case. 
 

2. Enter the description “Wind”. 
 

3. As this is a variable load, change the Action type to Variable. 

 

4. The Load Group LG2 is automatically created. Click  to display properties of the Load 
Group. 

 
 

The Load type determines the composition factors that are attributed to the load cases in this 
load group.  In this project choose Wind. 

 

5. Click [OK] to close the Load group manager and to return to the Load cases manager. 
 

6. Click [Close] to close the Load cases manager. 
 
Remark:  
Load groups 
 
Each load is classified in a group. These groups influence the combinations that are generated as well 
as the code-dependant coefficients to be applied. The following logic is adopted.  
Variable load cases that are independent from each other are associated to different variable groups.  
For each group, you set the load category (see EN 1991). The combination factors from the Eurocode 
are generated from the available load groups. When a generated combination contains two load cases 
belonging to different groups, reduction factors will be applied for the transient loads.  
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If the load is divisible, its different components are entered as individual load cases. As long as the load 
combination does not contain any variable load belonging to another group, no reduction factors may be 
applied. The different load cases of a divisible load are therefore associated to one variable group.  
Load cases of the same type that may not act together, are put into one group, which is made 
exclusive, e.g. “Wind X” and “Wind -X” are associated to one exclusive group “Wind” to avoid 
simultaneous action. 
 

Loads 
After input of the Load cases, the Loads menu will automatically appear: 
 
The first load case (LC1) includes two loads: 
 - Self weight of the bars 
 - Roof weight 
 

Switching between load cases 

Activate LC1 by selecting this load case with the mouse pointer in the combo-box: 

                   
 

Entering the self weight as linear load 

1. Cancel any possibly active selection by pressing <ESC>. 
 

2. Click on Line Force - on beam in the Loads menu. The dialogue Line Force on beam 
appears. 

 

3. In the field Type, choose Self Weight. The Direction is the global Z-direction and the Gravity 
coefficient is set to –1, so that the load is acting vertically downwards. 

 
4. Confirm your input with [OK]. 
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5. Select all the bars by means of the Select all  icon in the toolbar. 
 

6. Press <ESC> to finish the input. 
 

7. Press <ESC> once more to finish the selection. 
 

The self weight load is represented in brown: 

              
Next, the roof weight is entered as a surface load of 1,5 kN/m². Only the roof girders are loaded 
directly. 
 

Entering the roof load as a surface load  

In order to enter a Surface load on beams, an option called Plane generator will be used. It enables 
us to insert plane load in kN/m2 even though there is no plate (2D) member. And program redistributes 
this load into linear load in kN/m. 
 

1. Click on Plane generator in the Load menu. The Plane geometry dialogue appears 
 

2. The load Direction is Z and the System is the global coordinate system GCS. In this way, the 
load acting vertically downwards. 

 

3. Change the Value to –1,5 kN/m² and press [OK]. 
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4. Click on nodes N2, N3, N13 and N12 consecutively to define the rectangle on one of the roof 
planes. Press <ESC> and the rectangle will be finished (the last node N12 is linked to the first 
node N2). Press <ESC> again to finish the input. 
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5. The load stays in violet colour which means it is 
still in active selection. Click on the combo-box in 
the Properties window > Loaded beams and 
change the option from All to Advanced. 

 
  

6. In the Actions buttons choose the option Update 
beams selection to indicate that only the girders 
and not the longitudinal beams will be loaded 
directly by this surface load. 

 
7. Click on beams B2 ,B6 and B10. 

 
8. Press <ESC> to confirm the selection. 
9. In the Actions buttons hit Refresh to generate/recalculate the surface load to line loads on 

beams. A new windows appears 

 
10. The Recalculation of plane load to members – window appears. Hit Calculate button in 

bottom left corner. 
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You will see a refinement of the calculated line loads at the beginning of the girders. This 
happens because of the presence of the haunches. Haunches are refined automatically. 

 

11. Click <OK> to confirm. You will see now the recalculated line loads on beams. Recalculated 
loads are coloured in orange. 

 
 
Repeat steps above to procedure identical load on the right-sided roof plane. 
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Entering roof load as second load case 

Activate LC2 – Wind load case by selecting it with the mouse pointer in the combo-box: 

          
 

Entering a linear load 

1. Click on Line Force - on beam in the Load Menu. The dialogue Line Force on beam 
appears. 
 

2. Change the Type to Force. 
 

3. The load Direction is Z and the System is the local coordinate system LCS. The linear loads 
are acting in accordance with the local Z-axes of bars. 

 

4. Change the Value to -4,8 kN/m. 
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5. Confirm your input with [OK]. 
6. Select the bars where this load must be positioned: the roof girders and the columns. 
7. Press <Esc> to finish the input. 
8. Press <Esc> once more to finish the selection. 

                 

Adapting a load 

1. Select the linear loads on the roof girders and the columns of the first and last frame by clicking 
with the left mouse button on these loads. Mentioned members must have only half of the load 
value because only half of the loading width, affected by wind, belongs to them. 

 

2. The common properties of the 8 series are displayed in the Properties window. 
 

3. Change the Value from –4,8 kN to –2,4 kN in the Properties window. 
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4. Confirm the modification with <ENTER>. 

 

5. Press <ESC> to finish the selection. 
 
                   
Click [Close] to quit the Loads menu and to return to the Main tree. 
 
Note: 

The Command line includes a number of predefined loads: , which enable a 
fast and simple input of loads. 

Combinations 
After input of loads and load cases, the latter can be grouped in combinations. In this project, two code 
combinations are created, one for the Ultimate Limit State and one for the Ultimate Serviceability State. 
 

Defining Combinations 

1. Double-click on Combinations in the Main tree. 
 
 
 

2. Since no combination has been entered yet, the window to 
create a new combination automatically appears. 
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3. The Type of the combination is changed to EN – ULS (STR/GEO) Set B. With this envelope 

combination type SCIA Engineer will automatically generate linear combinations in accordance 
with the complex composition rules of the Eurocode. 
 

4. A warning message that controls the content of code combinations with respect to load type 
may appear. Close it with [Yes] 

 
5. With the button [Add all], all load cases can be added to the combination. Otherwise you can 

manually drag&drop load cases from the list of load cases (right frame) to the contents of 
combinations (left frame). 
 

6. Type “ULS” into Description row to distinguish the combination from the second one. 
 

7. Confirm your input with [OK]. The Combinations manager is opened. 

8. Click  or  to create a second combination. 
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9. Change the Type of the combination to 
EN-SLS Characteristic. Type “SLS” 
into Description row to distinguish the 
combination from the first one. 

 
 

10. Confirm your input with [OK]. 
 

11. Click [Close] to close the Combination 
manager. 
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Calculation 

Linear Calculation 
As the calculation model is completely ready, you now can start the calculation. 
 

Executing the Linear Calculation 

1. Double-click on Calculation in the Main window, or use identical icon  in toolbars. 

 
2. The FE analysis window appears. Click [OK] to start the calculation. 

 
 

3. After the calculation, a window announces that the calculation is finished and the maximum 
deformation and rotation for the normative load case is shown. Click [OK] to close this window. 
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Results 

Viewing results 
When the calculation is completed, results can be viewed. New service appears in the Main tree and 
also Properties window announces that Linear calculation is finished. 
 

Viewing the Reaction Forces 

1. Double-click on  in the Main tree. The Results menu appears. 
 

2. Below Supports, click Reactions. 

 
 

3. The options in the Property Window are configured in the 
following way: 
 
 The Selection field is set to All. 
 The Load type is set to Combinations and the 

Combination to CO1 - ULS. 
 The Values are wanted for Rz. 
 The Extreme field is changed to Node. 

 

 

 

 

 
4. The action button Refresh has a red highlight, i.e. the graphical screen must be refreshed.  

Click on the  button next to Refresh to display the results in the graphical screen in 
accordance with the options above.  
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5. To display these results in a table, the Preview action is used.  Click on the  next to 
Preview to open Report preview.  

 

 
 
Note:  
The Report preview appears between the Graphical Screen and the Command line. This screen can 
be maximised to display more data at once. 
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Viewing internal forces on beam 

1. In the Results menu, open the Beams group and select 
Internal forces on beams. 

2. The options in the Property Window are configured in the 
following way: 

 The Selection field is set to Current. 

 The Load type is set to Combinations and 
Combination to CO1 - ULS 

 The Values are wanted for My. 

  The Extreme field is changed to Global. 

3. Select columns and the roof girders of the centre (middle) 
frame using the left mouse button. 

4. Click on the  button next to Refresh to display the 
results on the graphical screen in accordance with the set 
options. 
 

  
 
To change the display of the results, the settings of the Graphical Screen can be adapted, as described 
in the following chapter. 
 

Configuring the Graphical Screen  

1. In the Properties window, click the  icon next to Drawing Setup. The options for the 
graphical screen are opened. 
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2. In the Representation field, choose Filled. 

 

3. The Angle of text is set to 0°. 
 

4. Click [OK] to confirm your input. 

5. In the Property window, click the  button next to Refresh to display the results in the 
graphical screen in accordance with the set options. 
 

 
6. Then click [Close] to leave the Results Menu. 
 

7. Press <ESC> to cancel the selection. 
Note: 
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To change the font size of the displayed results, you can use the Setup > Fonts menu.  In this menu, 
the different sizes of the displayed labels can be changed. 
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Code check 

 
SCIA Engineer steel modules include a number of powerful tools to perform the steel calculations in 
accordance with the chosen design code. 
The possibilities are as following: 

 Input of advanced steel data per member 
 Simple input and edition of buckling data 
 Input of reinforcements, stabilities against lateral-torsional buckling, cladding 
 Unit check of the cross-section 
 Optimisation of the cross-section 
 Fire-resistance check of a member 
 Input and calculation of frame connections 
 Input and calculation of diagonal connections 
 Automatic generation of sectional drawings 
 Automatic generation of assembly drawings and anchorage plans 
 Relative deformation unity check 
 etc. 

 
We will only explain the basics of the steel design in this Tutorial.  For more information regarding 
advanced steel calculations we refer to the Advanced Steel Training. 
 
Before the steel calculations can be started, the buckling parameters of the members need to be 
checked.  By means of the view parameters, the buckling lengths of the members can be visualised. 
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Buckling parameters 
 

Displaying the system lengths 

1. Select with the left mouse button column B1, the left column of the first frame. 
 

2. Click the right mouse button at an arbitrary position in the workspace.  Context menu lists the 
possibilities for the selected entity. 

 

3. In this menu select the   option. Limited View parameter settings 
window appears. 
 

     
 

4. Activate the System lengths and Draw cross-section options to display the reference lengths 
and the section of the bar. 

 

5. Activate the Local axes – Members 1D option to display the local coordinate system of the 
bar. 

 

6. Confirm your input with [OK].  
 

7. Press <ESC> to cancel the selection. 
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The figure shows that (default) system length Ly (blue line) for buckling around the strong axis (y-y) is 
total height of the column and Lz  (green line) for buckling around the weak axis (z-z) is half of the 
height. The girder in the middle of the column therefore supports the column for buckling around the 
weak axis, i.e. for bending in the Y direction. 
To modify the buckling data of a bar use the option Buckling and relative lengths in the Property 
window of the beam, if selected. 
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Setting the Buckling Parameters 

1. Select both columns of the first frame with the left mouse button. 
 

2. The Properties window shows the common properties of both entities. The Buckling and 
relative lengths are set to Default. 

 

  
 

3. Click the   icon next to Buckling and relative lengths. The Buckling data window 
appears. 

  
This window shows that the column is supported for buckling around the weak axis (zz) in the middle 
and that it is not supported for buckling around the strong axis (yy) in the middle – the grey triangle is 
missing on left hand side. 

4. Click [Edit] to change the buckling data.  The Buckling and relative lengths window appears. 
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5. On the Base Settings tab, several data can be changed. 
 

 The Name field contains the name of the buckling parameter, in this case BC1. 
 ky factor and kz factor: in these fields you can indicate that the program should calculate the 

buckling factor or you can choose a manual input of this factor.  A third option allows for a 
manual input of the buckling length (instead of factor).  

 Sway yy and Sway zz: in these fields, you can indicate if the bar is braced or not in the 
direction regarded. When you choose option acc. to Steel > Beams > Setup option, the 
default settings are used. 

 
Note: 
The default settings for the buckling parameters are displayed below Steel > Beams > Steel. 
The structure is by default non-braced for buckling around the strong axis and braced for 
buckling around the weak axis.  In other words, a frame in non-braced in the plane and braced 
out of plane, taking the presence of wind bracings outside of the plane into account. 

 

 Buckling systems relation: in these fields you can define the system length to be used for, 
amongst other things, torsional buckling and lateral-torsional buckling. 

 Relative deformation systems relation: in these fields you can define the system length to 
be used for the relative deformations (SLS check). 

 

6. On the Buckling data tab you can edit the parameters in detail.  The column consists of 2 
components, i.e. 3 positions are available: (1) at the start, (2) in the middle at the horizontal 
girder and (3) at the end, at the roof girders. 

 

 For instance, by modifying the Free option on position (2) for yy to Fixed, buckling of the 
column in the middle around the strong axis would be influenced as well. This would mean the 
system length around this axes would become also half of the total length ( = 2,5 m).  For this 
tutorial, the default options are kept. 
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7. Click [OK] to close this window. 
8. Buckling data window re-appears.  Click [Close] to close this window. 
9. Properties window now indicates that the buckling parameter BC1 is used for the columns of 

the first frame.  
10. Press <Esc> to cancel the selection. 

 
Remark: 
You can double check the buckling system setting by action button Graphical input of system length. 
Here you can also change free nodes to fixed (by clicking the red triangles at specific locations at the 
members) and the other way round, or change relations between buckling systems. 
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When the buckling parameters are set, you can continue with the steel check.  Before you proceed 
deactivate the System lengths and Local axes representation by means of the Fast adjustment of 

viewflags on whole model  option. 
 

Steel code check 

Double-click on  in the Main window to open the Steel menu. 
 

Displaying the Slenderness and the Buckling Lengths 

1. Click the Steel slenderness icon in the Steel menu. 

 
 

2. If this option is not available, you must restart the linear 

analysis using for example Hidden calculation  icon 
in the Project toolbar. 

 
 

3. The options in the Properties window are configured in 
the following way: 
 Selection field is set to Current.  
 Values are wanted for Lam y, i.e. the slenderness 

around  yy axis.  
 Extreme field is modified to No. 

 
 
 

4. Select column B1, the left column of the first frame and hit 

Refresh  button in Actions. 
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5. Change the Values field to Ly to display the reference length for buckling around the strong 

axis. Hit Refresh  button again. 

   
As already indicated in the buckling parameters, the reference length is 5m. 

 

6. Change the Values field to ly to display the buckling length for buckling around the strong axis.  
 

7. Hit Refresh  button again. 
 

 
 
 

The buckling length is determined as reference length Ly multiplied by buckling factor ky. 
 
Since the default determination of buckling length is used in this project we always recommend 
checking the final slenderness by the steps described above. You can proceed to the steel check now. 
A unit check is carried out in accordance with the standard.  The unit check includes both a capacity 
and a stability check. 
 

Steel Code Check – Ultimate limit state 

1. Click  in the Steel menu 
 

2. The options in the Properties window are configured in the following way: 
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 Selection field is set to All.  
 

 Type of loads is set to Combinations and the 
Combination to CO1 - ULS.  

 
 Filter is changed to Cross-Section. 

  
 For the Cross-Section choose CS1 - HEA200 to 

ensure that only the results for columns are displayed.  

 
 For the Values choose a un. check.  

 
 Extreme field is changed to Global. 

 
 
 
 
              
 

3. In the Property window, click the  button next to 
Refresh to display the results in the graphical screen in accordance with the above 
parameters. 

 
Graphical screen shows that the maximum unity check occurs for one of the middle columns. 
To understand the reason behind you can open the Report preview with a detailed 
representation of the performed steel check. You can find all input data, calculated 
resistances, code formulas and notices and warnings in the detailed output that usually 
contains a few A4 pages. 

 

4. Before opening the preview, set the Output option in Properties window to Detailed. Click the 

 icon next to Preview to open Report preview. 
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Check of steel  

This detailed report reveals that the column does not comply with the Combined bending, axial force 
and shear force check according to article EN 1993-1-1 : 6.2.9.1. and formula EN 1993-1-1: (6.41) in 
this particular project; different cross-section with larger inertia is required. Below is only part of the 
complete check: 
 

Combined bending, axial force and shear force check 
According to EN 1993-1-1 article 6.2.9.1 and formula (6.41) 

 
Mpl,y,Rd  100,85  kNm  
Alpha  2,00    
Mpl,z,Rd  47,88  kNm  
Beta  1,00    

 
Unity check (6.41) = 7,95 + 0,00 = 7,95 - 
  
Note: Since the shear forces are less than half the plastic shear resistances their effect on the moment 
resistances is neglected. 
Note: Since the axial force satisfies both criteria (6.33) and (6.34) of EN 1993-1-1 article 6.2.9.1(4) 
its effect on the moment resistance about the y-y axis is neglected. 
Note: Since the axial force satisfies criteria (6.35) of EN 1993-1-1 article 6.2.9.1(4) its effect on the moment 
resistance about the z-z axis is neglected. 
 
The member does NOT satisfy the section check! 
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SCIA Engineer allows for a simple and smooth optimization of the steel section, whether it does not satisfy of 
whether it is too “heavy” and overdesigned.  The program will automatically propose a cross-section section 
which complies with the unit check.  
 

Optimisation of the Steel Section 

1. In the Properties window, click the  icon next to Autodesign action. The settings of 
the Properties window are maintained, so that HEA200 will be optimised. 

Note: Steel optimisation works with cross-sections, not particular members. Therefore once the 
profile is changed, all members with that profile are changes as well. Using action button for 
Autodesign is therefore conditioned by using filter set to cross-section. 

 
The Autodesign of the cross-section dialogue looks like below 

 

 
 

2. This window again displays the maximum unity check for all members with CS1 - HEA200 
which is 7,946. Just above this value there is a maximum unity check to be reached (but not 
exceeded, which is by default 1.  

 

3. Click the Search for optimal button. The program will search within the profile library for a 
new cross-section and stops with the first one that satisfies the unity check. 
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It appears that HEA340 complies with the requirements: maximum unit check 0,916 
 

4. Confirm the optimisation with [OK]. 
 

 
Note: 
The project must be recalculated after the optimization. The changed cross-section modifies the 
self weight of the structure as well as the stiffness of the whole model, which will lead to a different 
distribution of the internal forces. 
This specifically means that, after optimisation and recalculation of the structure, the profile 
concerned could possibly reveal inappropriate. In that case, you must re-execute the optimisation 
in order to find a solution in an iterative manner. 

 

5. To quickly restart the calculation after an optimisation, use the hidden calculation command.  

Click on the Hidden Calculation  icon in the Project toolbar. 
 

6. Click [Close] to quit the Steel service. 
 
Whole structure can be optimised using the steps above again for another cross-section (CS2, CS3,...). 
However, the procedure was described and repeating it for all the members is not an intention of this tutorial. 
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Steel connections 
 
Steel connections in SCIA Engineer can be detailed in an advanced manner. Both rigid and hinged 
frame connections can be modelled, as well as bolted diagonal connections and grid connections.  
In this Tutorial, a rigid frame connection will be inserted between a column and a roof girder, as an 
isolated example. 

Activating the Steel Connection Input 

1. To obtain access to the steel connections, appropriate functionality needs to be activated first.  

Double-click on  in the Main tree to open the Project data and click on the 
Functionality tab. 

 

2. In the Steel part, activate the Frame rigid connections functionality.  The functionality 
Structural model is automatically activated as well, as this one is required for the definition of 
the connection. 

 
3. Confirm your choice with [OK] button. 

 
When the required functionality is activated, the Structural mode which is crucial for definition of steel 
connection, can be activated. Structural model, unlike the analysis model which represents the nodes 
and system lines, shows surfaces of cross-sections and better reflect the real appearance of the 
structure. 

Displaying the Structural model 

1. Zoom in on node N2, i.e. the node that connects column B1 and roof girder B2. 
 

2. In the Command line click on the Show/hide surfaces   and the Render geometry   
icons. The program displays the calculation model like this: 
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3. In this analysis model, the bars are arriving in the same node, i.e. node N2.  But in practice the 

girder is cut for instance at the column flange or vice versa.  In SCIA Engineer, you can 
indicate this through the structural model. 
 

4. Activate the structural model by clicking on view  Set view parameters  Generate 

Structural model   . 
 

                    
 
 
The structural model shows the structure as it will be realized in practice. On this model, you can 
introduce the connection because now its position is fully clear. 
 
Note: 
The structural model uses priorities of 1D members. The element with the highest priority value has 
priority over an element with a lower priority.  By default, an element of the Column type has a higher 
priority (100) than an element of the Beam (80) type.  Therefore, the beam is cut at the column flange 
and the column is a bit extended to be aligned with the top flange level of the beam. 
 
With Setup > Beam types (Structural), the priorities can be adapted. 
 
Steel connections are always based on the structural model. If the column continues, a connection with 
end plate on the girder is obtained; if the girder continues, a connection with end plate on the column is 
obtained. 
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Inputting a Steel Connection 
 

1. Double-click on  in the Main window to open the Steel service. 
 

2. Double-click on Frame bolted/welded-strong axis 
under Connections to enter a new rigid frame 
connection. 

 

3. The program asks for a point of connection now, 
select node N2. 

 

4. Now indicate the members between which the connection should be established.  The program 
automatically selects (and highlights) all bars arriving in node N2. As the connection should be 
inserted between the column and the roof girder, deselect girder B13. 
Press the CTRL (or SHIFT) key and click on the particular member with the left mouse button 
to deselect it. 
 

     
 

5. Press <Esc> to finish the selection.  Connection is inserted (by the mean of a flag named 
Conn1) and the properties, including components, are displayed in the Properties window. 

 
 

 

6. Now, the components of the connection can be entered.  Activate (check) the End-plate 
option.  The end plate is entered and immediately displayed in the graphical screen: 
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7. To change the properties of the end plate click the  icon next to the End plate option in the 
Properties window. Properties of this particular component are displayed and can be modified, 
if desired. 

 
 

8. Click [OK] to close this window. 
9. Now, the Bolts component can be checked/activated. 

 
 

The bolts are automatically displayed in the graphical screen. 
 

10. To change the properties of bolts, click the  icon next to Bolts option in the Properties 
window. 

 
11. For the Selected bolt position, an M20 – 8.8 is chosen.  A window informs you that the bolt 

position has changed.  
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Click Yes: the bolt positions, intermediate distances, edge distances etc. are automatically 
adapted to the new bolt type. 

 

12. The window furthermore shows that 2 bolt rows are active: the 1st Row and the 3rd Row. 
Check the 2nd Row as well to insert an additional bolt row. 

 
13. Click [OK] to confirm your input.  The bolts are displayed in the graphical screen. 
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14. To complete the connection, check the Top Stiffener and Bottom Stiffener components. 
 

 
Connection is now displayed in the same colour as the model.  To change this view, use the View 
parameters menu.  

 

15. Click the right mouse button at an arbitrary location in the workspace.  The menu lists the 
available possibilities for the selected entity. 

16. In the context menu hit Set view parameters for selected command. The View parameters 
settings window appears. 

 
17. In this menu, check the Welds and Coloured options. You can also disable (untick) Display 

label option. 
 

 
Close this menu with [OK]. 

 

18. In the Properties window, click the  icon next to Refresh to regenerate the input in 
the graphical screen. The connection is displayed in a rendered style: 
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The connection now is completely modelled and you can open the results. 
 

Checking the connection 

1. Select the connection by mouse cursor and in the Properties window set the following: 
 
 Type of load is set to Combinations and Combinations to CO1 - ULS. 
 For the Frame type, choose braced. 
 Output is set to Summary. 

 

2. In the Property window, click the  button next to Open Preview to display the results 
in Report Preview below the modelling screen. 

 
 
Output shows the internal forces, design resistances, results of unity checks and moment-
rotation diagrams. The most significant part of the output says that this particular connection 
does not satisfy the check, therefore we have to change the configuration of the connections. 
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In this case, the limit part is the Column Flange in bending (Ft,fc,Rd), as it is stated in the 
report as well. The user must change the used cross-section for the column, because the 
flange of the column cannot take the bending moment for this connection. 

 
3. Press [Close] below the Steel menu to return to the Main tree. 

 
 
Notes: 
 
Detailed output with all intermediate calculations can be also displayed if necessary. It covers many A4 
pages for just one connection to enable hand verification of the provided results. 
 
Connections are additional data, i.e. a connection can be copied to other nodes. 
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Document 
In this final part of the tutorial, we will explain how to make nice report of the calculation and design. 

Engineering report 

1. Double-click  in the Main Window or click   in the toolbar. 
Because no report was created before, Report_1 directly appears as a new application. This 
application is in a certain way independent on the SCIA Engineer application. That is 
significant also in the Windows main bar 

 
 

2. Click Insert button in the ribbon to start inputting items in the report navigator. Windows with 
New items appears just below the Insert icon: 

 
3. Using this window, various data can be added to the report. 

 

 Open the Libraries group and select Materials. Double-click in this item or hit  
button to add this item to the document navigator.  

 Add also Cross-Sections one row above. 
 Open the Structure group and double-click Members. 
 Open the Results group and click Internal forces on beam.  

 
4. You can directly see these items in the Navigator and on the paper preview as well: 
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Drag the items with the mouse to change their order.  

 
 

Displaying results in the document 

1. In the Navigator click Internal forces on beam. The red exclamation mark both in Navigator 
and preview indicates that the values presented are not up-to-date. In the Properties window 
the setting of this table is displayed. Parameters for displaying the results in the Engineering 
Report are configured in the same way as the parameters for viewing the results in the 
Results Menu of the SCIA Engineer application.  

 
 Selection type is set to All.  
 Type of load is set to Combinations and the Combination to CO1 - ULS.  
 Values are set to vertical reaction Rz.  
 Extreme field is changed to Global. 

 

2. Click the   button in the top ribbon to display the table in accordance with the 
predefined options. Red exclamation mark disappears. 
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Adding an image to the document 

1. Any picture from SCIA Engineer application can be set to Engineering Report. Either as print-
screen (that is unchanged for ever) or as live picture (that can be regenerated and is always 
up-to date). 

 
2. Prepare any scene in the 3D modelling window, for example the analytic model with loads. You 

can use the icons above the Command line to hide surfaces and rendering and show loads: 

 
 

3.  Click on button Print Picture in toolbars and select Live picture into Engineering Report 
 

 
 

4. Document picture properties dialog is opened. Here you can arrange the picture caption, scale, 
size etc. Use button Two at page at the top ribbon and click on button Insert & Close into 
selected report 
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5. Switch to Engineering Report application again and see the picture as the very last item in the 
navigator: 

 
 

Printing Engineering Report 

Once the report is completed you can print it or export into various formats (e.g. PDF, RTF, HTML) by 
clicking the top left button of the window. 
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Epilogue 
 
In this syllabus, the basic functionalities of SCIA Engineer for the input of a steel structure, including 
the steel calculation, were introduced by means of an example. 
 
After reading the text and executing the example, the user should be able to model and calculate 
simple structures consisting of steel bars. 
 
For more detailed information about steel calculations we refer to the Advanced Training Steel 
documentation or the dedicated Web help chapters. 


